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Chapter Two 
How to Produce and Manage Images with IT 

 
University of Fine Arts of Brera (IT) 

 

2D Image 
As it is largely known, most of the images, photos and drawings which are produced 
must be represented on a bi-dimensional surface. They are often intended to be “flat”, 
while in other circumstances different devices, such as the axonometric and perspective 
projections, try to create the effect of depth, that is of the third dimension. 
 
As to the photographic image, the use of computer allows to work it out in every aspect, 
both through simple operations of photo retouch and through more complicated actions 
such as the photomontage of different parts and different photographs. Beside, we can 
also produce graphic elaborations by using special effect, or by varying the original 
colours in intensity, saturation or composition. 
In this way, thanks to the various devices of recent software, even the most unbridled 
imagination of an operator is put to a hard test. 
In the field of drawing in itself, that is formed by lines and coloured areas, the 
instruments and effects at our disposal are numerous and effective but they generally 
produce less conspicuous results, if compared to the photographic image. However, given 
the difference between drawing and photography, the operator’s creativity is highly 
stimulated and his/her control on the started operation is strict: we can think about the 
multitude of compositions we can create by combining lines and regular or non-regular 
geometrical figures, or by using instruments such as “morphing”, to change one form 
into another, or effects capable to deform the drawing as we prefer. 
In this kind of work, the operator must pay a careful and continual attention because 
even the slightest indecision in his/her operative thought or an approximation in the 
carrying out can’t be hidden; on the contrary they are emphasised by the strict rigour 
which generally governs this kind of “programmed design”. 
It is also important to remember that, through given operations, it is not difficult to 
transform a drawing into something completely different, which we might call 
“metaphotography”; an image of photography which couldn’t be produced through the 
use of normal photographic technologies. 
 
In this way, once we have overcome the technical limits of drawing and we have reached 
the wide possibilities of the pictorial or photographic image, all the operative instruments 
above described can be used. 
If we refer to the traditional way of doing art, we could make a comparison with the 
painter’s way of working, and his first preparing the drawings and then transforming 
them into pictures. 

 

 

How to use Image processing software 
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 This field started with the photo-retouching software, as the well-known PhotoShop. 
These softwares permit to elaborate every kind of image or photograph working on the 
so-called bitmap images. 
Every type of contemporary media image passes trough this elaboration process. Here 
we give an examples of guided use of these tools to produce different kinds of images.  
Photoshop 

The aim of this tutorial1 is to make you understand the potential and possibilities offered 
by the softwares of the so called "photo retouching". This term, commonly used, is a bit 
too narrow. A software like Photoshop (or similar ones) allows us to go further and 
surpass the simple "retouching" of a picture or an image. It is like as if you were in front 
of a white canvas, with all the colours you can imagine (sixteen millions), brushes, 
pencils, aerograph or, if you prefer, glue, scissors and material to be cut and sticked, up 
to your final digital papier-collé. In fact Photoshop gives the chance to simulate all the 
traditional instruments, with the advantages and flexibility offered by the digital 
technology.  
And don't worry about making mistakes, because you can always go back and cancel 
what you have just done…therefore no more works to be thrown away because of a drop 
of colour that fell down in the wrong place, or because your cat chose your work as its 
bed for the night.  
Let's see more closely what we are talking about. 
The most commonly used software is Adobe Photoshop, so I will refer to it for my 
convenience. In any case there are many other similar ones, with very little differences, 
like Corel Photo Paint (which you find in CorelDraw), Paint shop Pro, Painter. You are not 
therefore obliged to use the software by Adobe; but, considering the differences on the 
screen, those who don't use Photoshop during the tutorial will have to find the equivalent 
controls. 
Once you launch the software, you will find yourself in front of a big void area, where 
your image will be visualized, and a series of icons, signals and menus on the sides of the 
screen. 
On the left you can find a list of icons that indicate the tools: brushes, airbrush, eraser, 
instruments of selection or filling... 
On the top you find the menus, listed and subdivided according to categories, from the 
opening, saving and handling of a file to operations about the modifying of an image, like 
rotations, cutting down ,handling of colour, contrast, to the filters, that up to now we can 
consider as special effects, and to the various helps. 
On the right you can find the signals, divided in groups, which allow you a quick and easy 
access to controls you can otherwise reach through the menu; the enlarging factor, the 
colours currently in use, the information about the image etc... Moreover in the signals 
we can find two other fundamental elements: the history and the layers. The history 
records all that you do and allows you to go back when you make mistakes or when you 
want to revise your steps, and exactly to the point you desire: the time machine of 
Photoshop. 
The layers are an essential element of the graphic of the calculator, which exist also in 
many other software of other kind (vectorial, three-D, Flash and similar ones). The 
concept which is at the basis is simple but it is very important to understand it because it 
makes the work quicker and more flexible. Every element of your composition can be 
positioned on a different layer. It is as if you worked on transparent sheets that are 
superposed and, seen together, compose the image. The layers are the transparent 
sheets. Imagine you have a composition with an image on the foreground and a 
background. By keeping these elements on two separate layers you will be able to 
modify, enlarge, eliminate, and move an element without influencing the other one. It is 
as if, once the drawing of the model on your sheet is finished, you suddenly realize that it 
would be better to move her on the left of your sheet. With Photoshop you don't need to 
cancel and redraw her, you must simply drag the layer with the model on the left. Not 
too bad. 

Let's consider a little practice. As we have seen, Photoshop allows carrying out a lot of 
operations. We start from the most obvious: the coloration of an image. We won't start from 

                                                 
1 This tutorial was done by Emanuele Pavarotti, and more examples can be found 

at http://multimediart.pixel-online.net/ 
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the beginning, but from a sketch or from a drawing by pencil or ink. And it's possible also to 
draw directly on the pc, but a good graphic tablet is necessary, and however joining the 
advantages of the traditional techniques to those offered by the digital give often the best 
results. I find the final aspect that the image assumes very interesting, a mixed "taste" of 
pixel and ink.  
A tablet will suit you however, in fact the greatest disadvantage of the mouse is the loss of the 
"wrist" (try to draw a dash...), besides the tablets are sensitive to the pressure and they 
simulate therefore also the enlargement of the line and the increase of its intensity. In a while 
they will also make your hands dirty of color! But don't worry, even without them excellent 
results can be reached, also considering that in a lot of operations the "wrist" is not necessary, 
while on the contrary the head always is!  
You can choose whether to import an image with your scanner or whether to use my 
"Frogman". The important thing is that if you choose to use your image this must be sketched, 
not a pictorial one, and black (or grey). You can also import a cartoon from a comic strip in 
black and white.  

.  
  
Let's begin. After having opened the file, make sure that the image is in RGB, that is color - 
image_mode_rgb color -. Increase the contrast - image_adjust_brightness/contrast - until to 
get a darker grey, almost black.  

 
  
Now a very important step, the essential command of the comics drawer: we have to make 
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sure that our colors don't influence "the inks": we release the background that contains the 
inks and we create a new layer. The new layer, that will contain the color, must be set below 
the inks. We now set the layer with the inks on multiply. To release the background click on it, 
to create a new level: - layer_new_layer - , to order the sequence of the levels all it takes is 
dragging them, to set on multiply: - menu - above the palette layers. Always rename your 
layers (in this case call one of them ink, the other color): it will be easier to find them again, 
especially when you work with many of them.  
Now while working on the layers under the inks the color will cover the white and will leave 
the black intact, this thanks to multiply.  

 
  
Start to color the sketch, for now with flat shades, with the brush. Assign a new layer for 
every part: one for the complexion, one for the suit, one for the cigar and the smoke. To be 
precise zoom the area in which you work with the navigator, and vary the dimension of the 
brush used according to the area to fill.  

 
  
Now it's time to give light; you start from the complexion, selecting it with the magic wand, in 
this way you won't go out of the edges (when there is an activated selection, all the 
operations modify only that area), then with the airbrush start to work as if it was a work on 
paper. To get a good result you have to hold a level of very low pressure, otherwise the 
nuances will appear rough. Alternate this tool to the brush when you want neater signs, 
change often dimension according to the area. When you make a mistake, return back in the 
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history of one or more actions. If you go out of the inks you can cancel with the tool eraser.  
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Remember to always work on the correct layer: don't colour the dark of the face on the layer 
of the jacket! For the background create another level and fill it with a gradient, I have used a 
radial type. Carefully choose your shades, with the computer it is easy to choose sour colors or 
too bright ones, considering that all are available with a click... have good taste and be sober.  
At this point we can add effects and details; for example, the fire of the cigar: create a new 
layer under the inks and paint with brush and airbrush the interested part. This however, is 
not sufficient because your cigar doesn't seem to shine. Create therefore a further new layer 
to be set above all the others, also to the inks; here, with the airbrush, using a level of low 
pressure, create the halo of light orange. If the shine seems excessive you can make it more 
transparent by regulating the opacity, - slider on the palette layers -. This very important 
function rules the transparency of that level and it will be always very useful. We notice that 
we have had to make an operation above the inks, putting a layer above these. In this way 
the multiply command doesn't have effect: it influences only the underlying layers.  

 
  
Let's pass to the background. Up to now it is a little too flat, let's move it with a texture that 
simulates a scraped wall. To do this we will use a combination of filters. By combining the 
filters, a lot of effects can be obtained, try to believe.  
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Start creating a new layer, and position it above that of the background, that is the second 
from the lower part, in this way, you will work behind the whole figure and you won't have to 
take care of not going above it. Select the airbrush and "bleach" the wall in irregular way, 
almost totally. This is our initial material that we will turn into a scraped wall. We now apply 
the first filter, a noise - filter_noise_add noise -. Let's blur slightly our noise - 
filter_blur_gaussian blur -, we now apply the effect emboss - filter_stylize_emboss -. Regulate 
this effect so that to create a surface similar to a rough rock. We are almost to the aim. We 
now need to fuse this layer with the background: go to the zone of selection of the blending 
mode, beside the opacity, and select overlay. Now, erase slightly the bump effect just created 
so that it amalgamates better with the rest. Also the eraser has to have a level of very low 
opacity; on the other hand the dimension can also be great. You can add a sense of profundity 
scaling the level - edit_transform_scale -; obviously in this case you will have to soften the 
neat borders that result. If you are not yet satisfied you can duplicate your layer and position 
it again with the tool move, so that to enrich the total. Frogman now starts to seem quite a lot 
sinister, but with a shade at his shoulders it will seem even more. Create a new layer, always 
under the character; now with the airbrush paint the shade that will also contribute to the 
determination of the space.  

 
  
Now you can add a writing: select the tool text, click where you want to write and write what 
you like. Now select what you have written and choose a font at your pleasure; I have chosen 
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the analog. At this point click twice on the layer containing the text: it will open the window of 
the effects; select stroke, to apply a contour, select a color and the thickness (2 or 3 pixels). 
Then I have applied the effects bevel and emboss and drop shadow.  
Try all the effects, and see what they produce. There will be very useful, and keep in mind 
that they can be applied to any level, not only to those of text. Once chosen the effects you 
can make the writing semitransparent by regulating the opacity with the usual slider. The 
blurred writings can be obtained by duplicating the layer, removing the effects that you have 
just put, moving it in the desired position with the tool move and applying the filter Gaussian 
blur and motion blur. You can also alter the dimension by using the command scale and the 
transparency by setting the opacity. Create a balanced composition by duplicating many times 
the writing.  
 
You can simply add then some cracks by drawing them on a new layer with a small pointed 
brush, then by applying emboss, and finally by blurring slightly the whole. If they detach too 
much, lower the opacity.  

 
  
Well, our image can be considered finished. Always save the file on more layers, but also a flat 
one, that occupies less space and results therefore more "manageable": perform - 
layer_flatten image - and then save apart. You now have the two definitive copies of your File. 
But it doesn't end here. Now that the work is finished we will realize some variations, you will 
see how easy and fast is to bring important changes to your work.  
  
To alter the color. Frogman, as you have certainly realized, is a mafia boss changed in a frog 
man, coming from a comic strip of science fiction. Then it seems legitimate to believe that the 
color of its skin has to be a beautiful green olive: take your file on layers, select that of the 
complexion and perform the command - image_adjust_hue/saturation -. Change the hue with 
the related slider. If the color is too strongly de-saturate it a little. If the result doesn't satisfy 
you, use the commands in the same menu color balance and brightness/contrast. What we 
have done is a very useful operation to correct shades that you have just realized and of which 
you are not satisfied. We have now used these commands a little too strongly, but they can be 
always useful for small adjustments and optimizations.  
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We bring another change: we give the image an ancient look: our mutated friend becomes a 
gangster of the 30s. Merge all the layers, then remove the whole saturation - 
image_adjust_desaturate -, at this point open the window color balance and slightly move the 
sliders increasing the red and the yellow in the shades and in the midtones. Try to get a good 
cuttlefish or blood tonality. Save your work.  

 
  
Here is another way of post-producing the image: let's create the "fast ghosts" (futurist 
definition...) around our character, to realize a composition with the same method of the 
transparent writings. We merge all the layers containing the color of our character, then we 
duplicate the resulted layer, bring it behind the original one, and apply the filter - blur_motion 

blur -. We regulate its position with move and we adjust the opacity. We duplicate the "ghost" 
many times and position it to create a balanced composition as in the photo. Save the work.  
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How to use Vectorial Design software 

At the basis of the 2d computer image, we have the so-called vectorial graphic, a 
drawing system that allows the use of geometrical tools to draw precise lines and shapes 
combined together, that remain unvaried no matter what scaling is used. The most 
known software of this kind are Freehand, Illustrator and Corel Draw.  
But n these section we mostly deal with the field of the interactive image and animation 
developed for the web, works of art born to live on the screen, as for example the ones 
created with the software called Flash. These images must be conceived as “open works”, 
within whose project the foreseen participation of the user should be fundamental. 

Macromedia Flash  
This tutorial illustrates, through 3 exercises, some key passages of the realization of an 
interactive Image, Labyrinth.2 
You don't need to have any knowledge of the software to follow the section Beginners. In the 
section two segments of the realization are explained step by step. 
The section for experienced users is an overview about the devices used to realize the total 
model of reference: here you won't find step by step tutorials, but an exchange of experience. 
It's a matter of answering to some hypothetical questions that could be born in the 
experienced mind when seeing the model of reference. 
 Beginners:  
1: How to create animated buttons  
2 : How to create Alpha level tones and animate them  
Experienced users:  
Steps of realization of the model of reference  
  
 

Beginners 
1 : how to create red the indication  
Create animated buttons 
  
Open a new movie (File>New ) 

                                                 
2 This section is by Jacopo Rovida, and an interactive version of the tutorial can be 

found at http://multimediart.pixel-online.net/ 
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Modify the properties of the movie (Modify>Movie) with the values:  
Frame rate: 16 f/ps (16 frames per second)  
Dimensions 740*450 pixels  
Background color : Black  
 
At this point we have our space of work.  
 
For first thing we create the indication of the point in which it is possible to enter the 
labyrinth.  
You are positioned on the frame 1 of level 1, Scene 1 of your movie. 
Let's recall the text-options from the toolbar  
 

 
by clicking right at the bottom the symbol "A" 
or  
Vindow > Panels > Character  
 
Then we choose a font and a color for the writing.  
 

We now select the tool text from the toolbar and we compose a writing we like  
 

 

At this point we select the text with the tool arrow , and we convert it in 
symbol/button.  
To convert in symbol once selected:  
Insert > convert to symbol (F8)  
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In the screenshot that appears, select Button, give a name you like (for us testo1), 
therefore give Ok.  
 

 
 

At this point select with the symbol, then:  
click with the second and select edit 
 

 
or  
Edit > Edit symbols  
or  
Ctrl+E 
In screenshot that appears, select the frame "Hit"  
 

 
and insert a key frame:  
Press F6 
or 
Insert > Keyframe  
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Once inserted the key frame : 
- select the frame  
-select the text and cancel it  

-draw with the rectangle tool a rectangle that occupies the same space, as in figure:  
 

 
This rectangle will be invisible for the user, but it determines the sensitive surface ("Hit") 
to the entry of the cursor of the mouse.  
 
Our task is now to insert an animation that will be visible when the user enters the zone 
delimited by the rectangle that we have drawn, that is when he gets closer and place the 
cursor of the mouse above the text that we have composed (currently situated on the 
frame "Up", that is the way in which the button appears when it is quiet, when the user 
doesn't interact with it).  
To give an animation to the button when the user passes above it, we have to intervene 
on the frame "Over", whose content is visualized when the arrow of the mouse passes on 
the sensitive zone that we have delineated ("Hit").  
Now select the frame Over  
 

 
And insert another key frame (F6).  
Now select the text (we are always in the frame Over)  
and convert it in symbol (F8).  
In the screenshot that appears select MovieClip and give a name you want (for us 
testo1_over).  
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At this point select the text of the frame Over, that has become a MovieClip (Filmed Clip) 
and press Edit (Ctrl+E 
 
We are in the movie clip now, that is a Timeline (temporal Line) independent from the 
principal movie, that follows its own rules of reproduction and that we can associate to an 
event, which is exactly what we are doing.  
  

  
Let's create an animation 
 
We select the frame 15 and we insert a frame (F5 or insert>frame). In this way our 
animation will last 15 frames.  
 

 
  
We now select our text and cancel it, and we draw a geometric figure at its place (in this 
case a rectangle):  
 

 
  
We now proceed to animate it:  
 
Insert > Create Motion Tween  
or 
Select the frame 1 and with the second key select "Create Motion Tween"  
  
The bar of the frames should be light blue. 
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Now insert a key frame (F6) to the last frame.  
 

We are in the frame 15, we move with the tool arrow the rectangle toward right. 
Now, if we place ourselves on the frame 1 and press Enter on our keyboard, we can see 
our animation.  
You can modify as you want the position of the object to the frame 15, the software will 
automatically draw the intermediary frames. You can also add intermediary key frames 
(for example, by pressing F6 to the frame 7) to insert some intermediary positions to the 
animation (in the model of reference the object rotates upward). 
In all the cases what you will get is that the software draws the lacking frames following 
the run of the straight line that connects the frame of departure (frame key number 1) to 
that of arrival (frame key number 2). 
  

  
 
SIf we want to add a fading in black, as happens in the model of reference, we resort to 
the effects:  
Select the object on the frame 15.  
Recall the panel of the effects:  
 

 
Press where indicated  
or  
Window > panels > effect  
Select the Alpha (transparency) from the Curtain menu  



 19 

 

 
 
Bring the value on 0%  
 

 
 
Our rectangle is now transparent in the frame of arrival. The result of the animation is a 
fading in black.  
We now return to the scene 1, that is to the movie that contains the button, that 
contains in turn, in the frame "Over", the animation that we have composed.  
We now publish our movie:  
After having saved it (if you have not done it yet)  
-press CTRL+SHIFT+F12  
or  
-File> Publish settings  
A panel with the options of publication should open.  
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If you want to visualize the file with your browser (have you installed the Plug-in?) select 
Flash (. swf) and Html (. html).  
Press OK, go to the folder where you have saved the movie and open 
NameYourMovie.html  
Your browser will open and you will see the movie.  
 
If you have installed on your computer Macromedia © Flash Player, you can also export 
only Flash, and open the file .swf in your folder.  
 
If you want to create a file to be transported on computers that don't have any devices 
to visualize flash or you have problems with visualization, you can create a projector 
(Windows or Mac) that is an executable (. exe) that weighs more than the simple movie 
because it also contains the program of visualization. The advantage is that it works 
independently from the condition of the computer on which it is made to run (if you have 
to produce a cd-rom to be distributed, it is for example worthwhile to export as 
projector,). Whoever will receive your cd-rom, he/she will see your work by opening the 
file in it contained, without needing to download anything from Internet.  

We remember:  

 

To acquire the basic abilities for 
using the program, you simply to 
open the program and follow the 
inside lessons.  
To do it:  
- Open the program  
- Click on Help > Lessons  
- Follow the lessons from the 
number 01 to the number 08.  
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Beginners 
2 : How to create the effects of shade on the labyrinth  
How to create tones with a level Alpha, and to animate them  
This phase of the tutorial implies that you have already carried out the preceding one. Some 
abilities will be given for granted.  
We return to the saved movie that you have used in the preceding tutorial.  
In scene 1, we create a new level:  
 

 
 
Press the indicated key  
or 
Insert>Layer  
We draw in the new level a circle, as if it were the labyrinth.  
 

 
 
We now create a third level that will contain the effects of light.  
We visualize the panels (Window>panels) Fill and Mixer  
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On the panel Fill, we choose from the descent menu Linear Gradient and at the two extreme 
we set a black color.  
We select then the cursor/tone on the right, and on the panel mixer we bring the value 
Alpha=0%  
 

 
 

On the third level, still empty, we draw a rectangle that covers partly the circle.  
 
We bring the level "testo1" (that with the animate button) higher than the other two, so that it 
doesn't receive the shade (to do it, drag the writing with the name of the level and bring it at 
the top).  
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Select the rectangle and convert it in symbol/Movie Clip (F8).  
 
We now select the rectangle that has become Movie clip.  
To edit it we can resort to the second key and select "Edit" but in this case it is better to use 
"Edit in Place", since the circle will be visible and we can verify the shadings.  
In the new timeline, we insert a frame (F5) at the number 240, for example, so that the shade 
will move slowly, during many frames.  
As we have seen for the rectangle of the preceding tutorial (chart create an animation) we can 
animate the shaded rectangle that simulates the light around the circle, by making it rotate 

with the tool rotate in the toolbar so that it has the part of fading tone Alpha always 
turned toward the centre of the circle, and making it complete a circle through various 
intermediary frames key.  
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It is important that the first frame is identical to the last one; the MovieClip, in fact, once 
arrived at the end of its 240 frames will start back from the beginning, that is from the first 
frame. With two different frames a leap would be visible.  
 
Step for the advanced user  
Passages of realization of the model of reference  
 
In this section we describe the passages of realization of the model. The part of 
construction in Flash of the experience is technically rather simple.  
  
Scene 1, frame 1 (contains an action "Stop()") 
 

 
The labyrinth has the key at its centre.  
  
This is the graphic symbol of the labyrinth in scene 1. In it are contained:  
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-level 1: the image of the labyrinth (graphic). Notice that the image is square. The 
roundness is given by a mask in the scene 1.  
-level 2: a button (visible in light green), with the exact shape of the walls of the 
labyrinth. Its states are: OVER-the light blue shape that is seen when we come in contact 
with the walls. HIT: the same shape as Over.  
To the button this action is associated:  
on (rollOver) { 
gotoAndStop (2); 
} 
  
This action brings the replay to Scena1, frame 2  
 

 
that is that where the corridors of the labyrinth are dyed of blue, and the key disappears 
from the centre. This is the state in which the user find himself when he gets in contact 
with the walls of the labyrinth. The labyrinth remains blue and the key doesn't reappear 
until the moment in which he doesn't go out.  
 
The blue dye is a graphic symbol.  
When the user goes out of the circle, the rectangular invisible button that surrounds the 
labyrinth (in light green) recognises the fact. In fact this button has only a state HIT, 
with associated the action:  
on (rollOver) { 
gotoAndStop (1); 
} 
 
that brings the action to the initial state (frame 1).  
 
If the user brings him to the centre of the labyrinth crossing the volutes of it, he can 
reach the key.  
 
It is a button with the sensitive zone extended to a rectangle, as you can see in this 
Onion skinning.  
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The action associated to this button is  
on (press) { 
gotoAndPlay ("key"); 
} 
 
Where Key is the Label after which there is the animation of the fading between the 
labyrinth and the iris of an eye.  
 
Both in the frame 1 and in the frame 2 you can find, on its level, a MovieClip with the 
effect of light on the labyrinth, given by a gradient that dissolves itself in Alpha in 
continuous rotation.  
Scena 1, Label Key: 
 
During the fading between the labyrinth (what goes to Alpha) and the iris (situated in an 
underlying level) the key is this time a MovieClip with this action associated to it:  
 
onClipEvent (enterFrame) { 
startDrag (""); 
} 
In fact during the animation the key follows the movements of the mouse.  
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Once reached the final frame (that has an action "Stop () "), the movie can be brought to 
the Flag "Key" since the key is again a button, with associated the action:  
on (press) { 
gotoAndPlay ("key"); 
} 

3D Image 
The three-dimensional representation of an object through computer has been, since the 
years 70-80, one of the greatest challenges in the development of Information 
Technologies. With the carrying out of the solid modelling, a first fundamental objective 
has been achieved: virtual sculpture through computer. It doesn’t matter if at the 
beginning it only concerned technical products; soon other forms were taken into 
consideration, like architectural structures and anatomic forms at last. 
 
The final aims of these technologies are more ambitious, like for example the covering of 
models mathematically created to render them as much similar to real objects as 
possible: the reproduction of the paints of the cars, of the hair and scales of animals, of 
building stones are still today a topic of studies and of development of new algorithms. 
All this combined with the work of placing these forms in a more and more realistic 
virtual environment, with shadows, lights, reflexes and transparency. 
All these technologies, together with those of animation of the created models, are more 
and more used in the industry which is able to perfectly simulate the image and the 
working of a product which only exists virtually, in the movies, and with the creation of 
always new special effects, in the production of animation, films and interactive 
videogames whose characters are not bi-dimensionally designed, but drawn as if they 
were true and realistic, not only in their forms but also in the movements, gestures and 
even in the expression of their “faces”. 
 
The amazing results obtained up to now by technology must be crowned by the most 
important objective; that of reproducing the human face with all the expressions of 
feelings and sensibility. It is obvious that many of the described representations require 
very expensive equipments and sophisticated technical competences, but the continuous 
technological development allows operating at high levels even with simple and cheap 
means. 
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The 3D image modelling process consists in the wire frame construction of an object 
structure trough computer aided design (CAD) tools, like the well known 3D Studio Max 
software. Once constructed this model can be moved and seen from different points of 
view as a “digital sculpture”. 
This technique is the one that permits to reach the most stunning realistic effects.  
In the game design –also at an elementary level- most of the effect is reached using the 
technic of the “texture mapping”.  
The name texture mapping is given to the technique trough which it is possible to “paint” 
over a 3D wire frame model. It is possible to use real colours, but mostly little parts of 
photographic or drowned images (called textures) are used to reach an impressive 
realistic –or surrealistic- effect. Sticking the photograph of the skin of a lizard on the 3d 
model of a dinosaur makes it appear real. 
The texture mapping technique is the most revolutionary and significative painting 
technique in the whole computer graphic field and it is at the basis of the realistic effect 
of the so-called virtual reality environments like in most of the better videogames .  
In the following section we treat some basics of it.  

 

 

 

How to create Texture Maps for 3D 

 
Every different 3D software has his own method to create texture maps, here we give an 
example using Autodesk 3DStudioMax3. 
 
Before starting to build a three-dimensional model in 3DMax of a head, you need to have a 
front image and a lateral one of the head itself at low resolution (es. 320x240) in jpg format.  
  

 
1 
1. Select "Viewport Backgroud" from the descent menu "Views".  
2. Select "Files..." to choose the image to be use as frontal background (ex. face.jpg) 
3. Set "Aspect Ratio" on "Match Bitmap" and "Front" in Viewport.  
4. Use in a second moment "Lock Zoom/Pan" to put correctly the image inside the window.  

                                                 
3 This example has been realized by Massimo Lojacono, and you can find more 

information on http://multimediart.pixel-online.net/ 



 29 

  
  
  

 
2 
1. From the panel "Create" select "shape" then "line."  
2. Set on "corner" both "Initial Type" and "Drag Type"  
3. Draw in the window "Front" the perimeter of the face and close the shape by making the 
end point coincide with the initial one.  
  
  
  

 
3 
1. From the panel "Modify" select from the descent menu the modifier "Extrude."  
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4 
1. Make sure that the settings of "Extrude" correspond to those of figure 4.  
  
  
  

 
5 
1. From the panel "Modify" select from the descent menu "Edit Mesh"  
2. Select first the button "Face" and after all the faces of the "Mesh"  
3. Press Delete on the keyboard and at the question "Delete isolated vertices? " select "No".  
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6 
1. Select the button "Vertex."  
  
  
  

 
7 
1. Select the button "Create"  
2. Create some vertices in correspondence to the key points of the morphology of the face (in 
this phase you need to imagine the points that will be subsequently moved so that to delineate 
the features of the face).  
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8 
1. Select again the button "Face" and then "Create"  
2. By joining 3 vertexes at a time we will create some triangular faces that will form the 
surface of the visage.  
3. It is important to make sure that the faces created on the right and on the left of our visage 
are symmetrical enough as you can see in the figure 8.  
  
  
  

 
9 
1. The problems of visualization of the faces are due to the fact that we are probably seeing 
the non visible side of our triangle. In fact in the sofwares 3D a side of the polygon is usually 
visualized to lighten the calculation of the motor of rendering so that to make our operations 
quicker.  
2. To make up for the problems above you need: first of all, to make sure that the settings of 
visualization of the window Front correspond to those of figure 9 and you do it by pressing the 
right button of the mouse with the cursor positioned high on the left in correspondence to the 
writing "Front"; then you need to reverse the "normal" of the non visible faces in the window 
"Front" using the key "Flip" inside the panel "Surface Properties" in "Edit mesh".  
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10 
1. Load and position in the window "Left" a background that refers to the side vision of the 
head (es. profile.jpg) using as before the descent menu "Viewport backgound". 
2. Select the button "Vertex" and then the one "Select and move" in the "Main Toolbar".  
3. By using both the window "Left" and the "Front" one, select and move one or more vertices 
in correspondence to the feature of the visage in background on which we are working.  
  
  
  

 
11 
1. This operation is the one that summarizes at best the technique of "modeling 3D", that is 
how to manage to interpret a 3D object using 2 bidimensional images of the same object and 
connecting them. It is not only a matter of mere automatism, in this phase you will have to 
give wide space to your anatomical knowledges and sensitive experiences as it happens when 
you model -for example- the clay in the reality.  
2. During the modeling the window "Perspective"is very useful which gives the possibility to 
model the form directly in three dimensions.  
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12 
1. By using the same method previously used, create some vertices in correspondence to the 
head and the nape so that to build the framework to complete the rest of the head (to clone 
one or more vertices select it and by holding shift pressed move it to the point in which you 
want to position the new vertex or vertices).  
  
  
  

 
13 
1.Now create the faces that will constitute the whole surface of the head, by joining all the 
vertices you have just created. 
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14 
1. According to the powers of our PC but above all to the further use of the 3D object we are 
considering it is possible to increase its definition and therefore the realism thanks to the 
modifier "Mesh Smooth"  
2. Select it from the descent menu of the panel "Modify"  
3. Set "Iterations" on 2  
4. The object is now ready to be submitted to "Texture Mapping."  
  
  
  
  

A very useful low polygon 3D software for using in game modeling and texturing is 
Milkshape 3D, a software expressly created for modeling 3D games characters: 
http://www.swissquake.ch/chumbalum-soft/ms3d/download.html (download) 
http://www.swissquake.ch/chumbalum-soft/ms3d/tutorials.html (tutorials) 
 

 

 
 
 

 

Virtual Sets 
Technical suggestion about the use of commercial Videogames for the 

realization of virtual spaces to be used as environments for customised 
adventures. 

  
The commercial videogames can be used and edited also in indirect ways. Maybe that for 
creating a videogame, we need a virtual environment in wich set up an adventure. We 
can create a 3D environment with a 3D software, or we can arrange a photographic 
photo-set. Otherwise, we can make an hybrid between the two things, by creating a 
virtual set directly inside a commercial videogame.  
Below, you can see two examples of what it is possible to do by conceiving a 3D 
vedogame as a virtual set. The first example is from Call of Cthulhu. The game is an 
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adventure where is possible to explore many different areas with very different 
environments. Furthermore, no weapon is visible in most of the game's levels.   
Using a software for capturing images and videos from videogames (as Fraps), we can 
capture a number of frames for creating a point&click 2D path. In this case, we have 
captured screens from the inside of a photography darkroom. 
 
Call of Cthulhu 
Those are part of the screenshot captured during the game... 
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...then you can have a movie of the final result, after having arranged with Neobook the 
captured images in a 2D sequence, that can be used and enriched by adding hotspots 
and other hypermedial elements. 
Obviously this isn't a finished game, but only an example of what it is possible to do 
using a commercial videogame as a virtual set for our poin & click customized adventure. 
In the tutorial section of the Learningame portal you can download both the .pub file (the 
project) and the executable one, in a way that you can make your tests on the 
functioning of Neobook (See in the Software section of the portal). To work on the .pub 
file, simply open it with Neobook. 
 
 
 
 
 
 
Golf 
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The second example is from Golf, a sport videogame that presents many editable 3D 
natural environment. The screenshots were captured with Fraps again, but this time we 
have built with them a beautiful 360 degree panorama, similar to what is possible to 
realize with a photo camera. The panorama was then used to create an interactive frame 
with Adventure Maker. 
Below you can see some examples representing the singles shots taken by the game.  
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Always in the tutorial section of the site you can download the .zip file including the .exe 
application and the source file. For mounting correctly the source file you must have 
installed Adventure Maker: go into the Program folder of windows, go into Adventure 
Maker's Folder, and then copy our folder into the Projects folder. Now start the program 
and open the project named GOLF, enjoy. 
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Note that the last two images are those mounted into the .exe created with Adventure 
Maker. 
The first picture is the one resulting from the stitching of all the captured images, the 
second is the same picture but elaborated with Photoshop. Remember that (in Adventure 
Maker) the panoramas require a 2048x2048 image to be created, as you can see in the 
Adventure Maker Tutorial. 
By launching the .exe file that you can download on the site, you can pass from the right 
panorama (made with the second square image) to the wrong one (made with the not 
elaborate image), so you can see the difference. 

 


